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related to commercial computer software
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release, perform, display, or disclose commercial computer software or commercial
computer software documentation. No
additional government requirements
beyond those set forth in the EULA shall
apply, except to the extent that those
terms, rights, or licenses are explicitly
required from all providers of commercial
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the DFARS and are set forth specifically in
writing elsewhere in the EULA. Keysight
shall be under no obligation to update,
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defined by FAR 2.101, pursuant to FAR
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the U.S. government acquires no greater
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27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.
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Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It
calls attention to an operating procedure, practice, or the like that, if not
correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not proceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

WARNING
A WARNING notice denotes a hazard. It
calls attention to an operating procedure, practice, or the like that, if not
correctly performed or adhered to,
could result in personal injury or death.
Do not proceed beyond a WARNING
notice until the indicated conditions
are fully understood and met.
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Introduction

Overview of the Guide
This guide provides a detailed description of the Keysight N5991 HDMI
Frame Generator.
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Document History
First Edition (March 2020)
The first edition of this user guide describes functionality of software
version 1.0.

Keysight N5991 HDMI Frame Generator User Guide

7

1

Introduction

HDMI Frame Generator - Overview
The HDMI (High-Definition Multimedia Interface) Frame Generator
software (also known in short as “Frame Generator” or “software”) is a
stand-alone software utility. It provides semi-automatic control of Keysight
Technologies’ M8195A AWG (Arbitrary Waveform Generator) TMDS and
FRL Signal Generator for physical layer tests.
The Frame Generator is a flexible tool for trouble-shooting and debugging.
it complements the full Test Automation Software (N5991HP1A), which
provides automated physical layer compliance tests and device
characterization. It allows a wide range of HDMI video formats to be
generated and provides control over parameters such as color depth and
color code. It comprises jitter insertion for jitter tolerance tests to set the
skew and other key parameters. The software runs on a standard Windows
PC and controls the hardware test resources through appropriate
interfaces, such as a LAN (Local Area Network).

8
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Test Instrument Setup
M8195A Single Module setup / 10
M8195A Two Module setup / 11

Prior to using the HDMI Frame Generator software for connecting
instruments, Keysight recommends setting up the test instruments and
establishing the required connections.
1

Connect the instruments (AWG and other instruments, such as, signal
and waveform generators) to the controller PC via USB or LAN.

2

Establish all required cable connections between the instruments and
the DUT (device under test).

3

Switch on the PC and instruments.

4

Start Keysight “IO (Input Output) VISA (Virtual Instrument Software
Architecture) connection Expert” and check the connections for the
instruments.

5

Set the correct IP addresses for the instruments.

The AWG setup can be used in two different configurations:
•

based on single M8195A module (TMDS only)

•

based on two M8195A modules and an M8197A synchronization
module

2

Test Instrument Setup

M8195A Single Module setup
This setup consists of a limited HDMI test configuration.
It does not have any instrument intra-pair skewing capability, can only
reach up to around 8Gbit/s and does not support FRL testing.

Figure 1

Connection diagram for an M8195A single module setup

For a full coverage of HDMI PHY testing, the M8195A two module setup
(shown further) is required.
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M8195A Two Module setup
This setup consists of two M8195A 2-channel modules and a M8197A
multi-channel synchronization module.

Figure 2
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Connection diagram for an M8195A two module setup
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Using the Software

Connecting to the Instruments
After the HDMI Frame Generator is launched, the software is in “offline”
mode. This means that any user inputs remain ineffective until the
software is connected to the instruments. Click the “Connect…” button
(see Figure 3) to open the “ConnectDialog” window. Doing so enables you
to either enter or modify parameters that are necessary to establish the
connections to the signal generator and complementary instruments, such
as power supplies.

Figure 3

14

HDMI Frame Generator main window (Instruments in disconnected state)
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Suitable cable connections between the PC and the instruments are
required, such as LAN or USB-to-GPIB connections. The specific
connection is reflected in the name-string of the instrument. For details
on naming conventions, refer to the Keysight IO Libraries.
On the “ConnectionDialog” window (see Figure 4),
1

From the ‘Signal Generator’ drop-down options under “Instrument
Type”, select an AWG configuration:
• ‘M8195A - single module’: if a single M8195A hardware is used.
• ‘M8195A - two module’: if two M8195A and a M8197A sync module
hardware are used.

Figure 4

2

Connect Dialog window

Specify the IP address of the AWG Host PC. This is the PC, which is
connected to the hardware and runs the AWG firmwares. The default
entry “localhost” is valid, if the HDMI Frame Generator software is
residing on the controller PC of the AWG system.
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Select and specify the modules. Each generator and the
synchronization module is specified by its VISA address, which includes
its IP address.
• For the option ‘M8195A - single module’, enter the VISA address of
the AWG module to the “Clock, Data0” and “Data1, Data2” text
boxes, respectively. This module generates all TMDS signals.
• For the option ‘M8195A - single module’, enter the VISA address of
the first AWG module to the “Clock, Data0” text box. This module
generates TMDS Clock and TMDS Data0 signals. Enter the VISA
address of the second AWG module to the “Data1, Data2” text box.
This module generates TMDS Data1 and TMDS Data2 signals. Enter
the VISA address of the ‘M8197A synchronization module’ to the
“Sync module” text box. This module synchronizes and de-skews
both the AWG modules.

4

From the ‘SCDC Type’ drop-down options under “SCDC Controller”,
select an option:
• Total Phase Aardwark
• Allion SCDC Controller

16

5

Click “Show Connection...” to view the basic connection set-up for the
selected configuration.

6

After setting the desired configuration, click “Connect”. The software
checks the availability of the desired connections and, if available,
establishes the instrument connections. Once connections are
successful, the label of the “Connect” button on the main window
changes to “Set”. Also, the functionality of this button is modified;
wherein, clicking “Set” applies the selected video format (and other
such formats) to the connected instruments.

7

Unless you are an advanced AWG user and have created and loaded
customized HDMI settings individually, click “Apply HMDI Setting and
Close” to exit the “ConnectDialog” window. The necessary HDMI
settings for the AWG system are applied automatically. Note that you
must first start the AWG setup specific firmware(s) on the Host PC.

8

Click Cancel, if you wish to terminate the “ConnectDialog” window
without connecting.
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If no Bias-Tees are used, the M8195 hardware caters for the offsets
required by the HDMI Standard. To do so, all channels must always have
the correct terminations applied. Removing its termination or applying a
wrong termination results in the safety-disablement of the M8195A
outputs. It is very important that all channels are properly terminated and
an over-voltage condition must always be avoided. If not correctly
performed, this setup could result in damage to the M8195A hardware
and any connected instruments. Modifying connections against the
recommended setup shall be done at your own risk, but it may cause
over-voltage conditions, wrong terminations and interfere accurate
functionality of the HDMI Frame Generator software. Keysight
recommends proper adherence to every instruction regarding
connections.
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Main window
Once the connection to the instruments have been established
successfully, the main window is displayed as shown in Figure 5. It offers
basic functionality as well as access to top-level test parameters along
with the status information.

Figure 5

HDMI Frame Generator main window (Instruments in connected state)

After the parameters have been set, perform the following steps:
1

18

Click “Connect”. The “Connect” button initiates a dialog box that helps
in establishing a connection with the instruments, such as a signal
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generator, selected by a user. For more information, refer to
“Connecting to the Instruments” on page 14. The “Connect” button
automatically changes to the “Set” button after the Frame Generator is
connected to the instruments. Click the “Set” button to download the
pattern and set the clock frequency for the selected video mode.
2

After the Frame Generator is connected to the instruments, the
“Outputs” button appears alongside the “Set” button. Click “Outputs”
to switch On/Off the AWG outputs. If the label below this button is
Green in color, it indicates that the outputs of the AWG are switched
On, wheres, Red indicates that the AWG outputs are switched Off.

3

To download patterns, click the ‘Set Setting’ option in the “File” menu.
Once the patterns are downloaded, the “Start/Stop” button appears.
Click the “Start/Stop” button to start/stop the sequence.

4

Click the “Setting...” button to save the current settings of the Frame
Generator to a file. You may re-load this file into the Frame Generator
to assign the saved settings in the current state of the Frame
Generator software. The ‘Settings’ file is capable of containing multiple
settings. For more information, refer to Setting Dialog.

5

Click “Close” to exit the HDMI Frame Generator software.

TMDS Mode
The parameters for the TMDS Mode are shown when the FRL Mode check
box is unchecked (see Figure 4):
The properties of the video frame are divided into three sections:
1

Video Format

2

Packets

3

Video Content

Video Format
The “Video Format” section in the upper part of the main window allows
you to select several parameters.
For HDMI TMDS testing, the parameters available are described in Table 1.
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Table 1

Parameters for HDMI TMDS testing

Parameter name

Description

Video Mode

Using the drop-down selection box, select the desired Video Mode from a broad choice of CEA-861 video
modes.

Color Depth

Choose a Color Depth of 24, 30, 36 or 48 bits.

Color Mode

You may select the Color Mode, which includes RGB as well as multiple YCbCr modes. The quantification
can be Full Range or Limited Range.

Content

Select the Content flag (Not specified, Graphics, Photo, Cinema or Game) in either 2D or 3D formats
(Frame Packing, Side-by-Side (half) and Top-Bottom).

Parameters that are available for check box selections are:
•

Null Packets—Check this option to fill up the blanking periods to
achieve balanced pattern.

•

DVI Compatibility Mode—Check this option to enable the DVI interface,
which transfers video only.

•

Audio—Audio output is accessible if supported by the hardware.

•

Scrambled—HDMI 2.0 introduces scrambling to reduce EMI and to
improve the DC balancing. To send a scrambled video, select the
corresponding check box. Before performing any test using the
scrambling option, you must perform an extra step. It is necessary to
enable the scrambling in the sink using the “HDMI SCDC Controller”.

•

TMDS Clock 1:40: Check this option to change the TMDS data bit rate
to 40 times the TMDS clock rate instead of 10. In the same manner as
that for Scrambling, it is necessary to use the “HDMI SCDC Controller”
to inform the sink of the relationship between the ‘TMDS clock rate’ and
the ‘TMDS data bit rate’.

Packets
To the right side of the main menu, select one or more “Info Packets”:

20

•

AVI Info Frame

•

General Control

•

SPD Info Framework

•

Vendor-Specific

•

Audio Info Frame

•

Gamut Metadata

•

Other Packet
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These packets are sent with each frame during the blanking period. Note
that these parameters are only available for TMDS Sink testing.
Packet Position Offset
You can select the position of the desired packets in the blanking period.
The offset of the packet position is relative to the “Hsync Active Start”. The
value ‘0’ places the packets directly after the “Hsync Active Start”. Any
value above ‘0’ shifts the first and all residual packets by the amount of
symbols as defined in this field. For example, the value ‘2’ shifts the
appearance of the first packet by 2 symbols from the “Hsync Active Start”.
The possible “empty” parts between the “Hsync Active Start” and the first
packet position is filled with control characters.
Packet Viewer/Editor
The contents of the desired packets can be viewed and edited.
Click “Edit...” to edit the packets on the “Packet Viewer/Editor” window as
shown in Figure 6.

Figure 6

HDMI Frame Generator Packet Viewer/Editor

In this window, every bit of each packet can be modified. To edit a packet,
select it from the drop-down box in the top left-hand corner of the
window. The check box “Send Packet” determines whether the packet is
actually transmitted in the video stream or not.
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Then, click to edit the corresponding value from the list of “Binary Value”
or “Hex Value” of a packet. Packet configurations can also be saved to a
file using “Export...” and loaded from a file into this dialog using the
“Import...” button.
Click “Close” to exit the “Packet Viewer/Editor” dialog. Once the dialog is
closed, make sure to click the ‘Set’ button in the main window for the
changes to take effect.

NOTE

When a parameter is changed in the main window, which affects the
packet contents (such as, video mode, color mode, 3D mode, and so on),
all packets are reset to their defaults values in order to reflect the
parameter change.

Video Content
You can set the video content in the center of the right-hand side of the
Frame Generator main window. This section provides control of the
parameters that define the horizontal color gradient. Note that these
parameters are only available for TMDS Sink testing.
This section offers the following basic options:
Default
A gray bar is created according to the protocols defined in the Compliance
Test Specification (CTS). See Figure 7.

Figure 7
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Preview for default Video Content
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Color Bar
A color bar, with 8 vertical bars, is created starting from white at the left
and ending with black at the right along with an intensity of 75%. See
Figure 8.

Figure 8

Preview for Color Bar Video Content

Parametric
A parametric color scale is created. If this Video content is selected, a
dialog appears that allows you to set the parameters for the color scale. It
is the same dialog as will be opened if the ‘Color Gradient Setup’ option is
selected from the “Edit” menu of the main window. For more details, see
Color Gradient Setup.
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Range Marker
This is a special pattern to determine the correct display of full and limited
range colors. The three black bars should appear as a single bar when the
display is “Limited Range”, or it should appear as a black bar between two
dark gray bars when the display is “Full Range”. The same principle applies
to the three white bars. See Figure 9.

Figure 9

Preview for Range Marker Video Content

Chess Board
A simple chess board pattern with 8x6 fields is shown in Figure 10.

Figure 10
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Preview for Chess Board Video Content
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Y420 Test Image
This is a special pattern combining the “Y420 B&W Bar” and the “Y420
Color Bar” according to HDMI 2.0 CTS. This test image verifies that a DUT
shows YCbCr 4:2:0 content correctly. This pattern is available for HDMI 2.0
only. See Figure 11.

Figure 11

Preview for Y420 Test Image Video Content

Y420 B&W Bar
This is a special black and white pattern defined in HDMI 2.0 CTS. This test
image verifies that a DUT shows the YCbCr 4:2:0 content correctly. See
Figure 12.

Figure 12
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25

3

Using the Software

Y420 Color Bar
This is a special color bar pattern defined in HDMI 2.0 CTS. This test image
verifies that a DUT shows the YCbCr 4:2:0 content correctly. See
Figure 13.

Figure 13

Preview for Y420 Color Bar Video Content

21:9 Test Image
This is a special wide-screen pattern to determine the correctness of the
aspect ratio. The aspect ratio is considered to be correct, if the displayed
black portion is a square and not stretched or deformed. See Figure 14.

Figure 14

Preview for 21:9 Test Image Video Content

Images
Images are loaded from the directories on your local disc to the image list
by clicking “Add...”. If multiple images are added to the image list, you can
toggle between them. Note that the image is not stretched. Hence, if the
image size is smaller than the screen resolution, the image line and the

26
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image row are repeated until the screen is covered. If the image size is
bigger than the screen resolution, the image is truncated. Click “Remove”
to delete images from the image list.
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FLR Mode
For HDMI FRL testing, select the FRL Mode check-box (see Figure 15).
Unlike HDMI TMDS, where the sink testing checks for the display visually;
HDMI FRL requires character error detection.

Figure 15

HDMI Frame Generator main window for FRL mode

The properties of the FRL mode are divided into three sections:

28

•

Video Format

•

Link Training Pattern selections
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Video Format
The available parameters for FRL mode are:
Video Mode—The desired Video Mode can be selected from a broad choice
of FRL video modes by means of a drop-down selection box.
FRL lane count—A value of either 3 or 4 appears depending on the Video
Mode selected.
Auto FLT—If checked, the link training is done automatically. Note that this
option requires the SCDC Controller.
Link Training Pattern selection
The options FRL Lane 0 to FRL Lane 3 allow you to select the pattern for
each lane.
Once the patterns have been downloaded (by clicking the “Set Settings”
option in ‘File’ menu) the following actions are possible:
•

Apply selected patterns—applies the patterns selected in the FRL Lane
0-3 drop-down boxes.

•

Test pattern—applies the test pattern to each lane.

•

LTP5-8 pattern—applies the FRL link training pattern to each lane. It is
composed by 4096 18-bit characters starting with four SR characters
followed by 4092 characters by encoding scrambling LFSR output.

•

End—finishes the FRL testing.
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Save / Load Settings dialog
Once all parameters are set as desired, use the “Save / Load Settings”
dialog to manage settings, either as single setting or as setting lists as
shown in Figure 16.

Figure 16

Save / Load Setting dialog

The “Setting Name” contains the name of the actual setting and can be
modified by the user. This name is replaced by a default name even if one
of the controls on the main window changes the mode.
You can add a comment in the “Comment” text box.
Each setting contains all setting values that are visible in the main window
and the frame timing setup dialog. It does not contain the images itself but
the file names of the images. For each setting, you can do one of the
following actions:
•

click “Add” to add the setting name to the list of settings,

•

click “Save” to save the setting on the hard disk as a setting file, or

•

click “Load” to load a setting from the hard disk.

The setting list contains all the settings that have been added using the
“Add” button described above. To manage this setting list:
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•

Click “Activate Entry” to activate the setting. Alternatively, you may
double click an entry to activate it. Activating a setting sets the
corresponding values of each associated parameter in the main window
and activates the setting on the instrument.

•

Click “Remove Entry” to remove any setting from the settings list.

•

Click “Load List...” and “Save List...” to load and save, respectively, a
settings list.

•

Click “Close” to exit the dialog.

Main menu
File
The options in the File menu are:
•

Clicking “Connect” initiates a dialog box, which establishes the
connection to the instruments selected by the user. For more
information, refer to “Connecting to the Instruments” on page 14.

•

Clicking “Set Settings” downloads the pattern and sets the clock
frequency for the selected video. In ‘FRL’ mode, the SCDC controller is
initialized and if “Auto FLT” is selected, the automated link training is
initiated.

•

Clicking “Save Segments At” saves an HDMI video frame pattern in a
location of your choice.

•

Exit closes the current instance of the HDMI Frame Generator software.

Edit
The options in the Edit menu are:
•

Frame Timing Setup

•

Color Gradient Setup

•

Instrument Parameters Setup

Frame Timing Setup
The “Frame Timing Setup” window allows access for advanced users to all
relevant timing parameters. The parameters are listed in a table and can
be set individually, as shown in Figure 17. Note that this setup applies only
to HDMI TMDS testing.
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Figure 17

Frame Timing Setup dialog

Use this window for actions such as to stress your device by applying
deviations from the standard format or to generate your own video pattern
by starting with a reasonably similar standard pattern.
Some of the parameters influence the data rate. If a data rate deviation is
to be generated, you may achieve so by changing the Frame Rate. The
data rate can be computed by:
DataRate = (Hblank + Hresolution) × (Vblank + Vresolution) × Bits per pixel
× Frame Rate
Click “Ok” to apply the selected parameters or simply close this window to
exit without saving changes.
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Color Gradient Setup
This sub-menu provides additional options that are not available from the
“Video Content” group of the main window. It is shown in Figure 18 and
offers the following choices:

Figure 18

•

Color Gradient Setup dialog

Adjustable Color Bar—Color Bar generates the SMPTE (Society of
Motion Picture and Television Engineers) pattern.

Figure 19

Preview of Adjustable Color Bar Video Content

•

Parametric Gradient—The Parametric mode allows you to define
independent start and stop values for the three colors. In addition, a Bit
Mask can be set for each color. It is used for blanking specific locations
in the pattern and should be entered in hexadecimal format.

•

Load from File—This will read frame data from a file.

•

PRBS-Function—The pseudo-random binary sequence (PRBS) function
generates a pseudo-random color scheme.
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After selecting the video content:
• Click “Apply” to calculate the selected pattern, load this pattern into
the instrument, switch to other areas of the software for further
changes or tests while the “Color Gradient Setup” window remains
active. Depending on the processing power of the CPU along with
the selected parameter combinations, the pattern calculation and
loading may take up to a few minutes.
• Clicking “Preview” displays the pattern on the PC monitor as shown
in Figure 19.
• Clicking “OK” adopts and saves the selected parameters without
applying them. Thereafter, the window is closed. The changes made
in this window are made effective only when you click “Set” on the
main window. By doing so, advanced users can combine multiple
parameter changes along with reducing calculation and loading
time.
• Click “Cancel” to close the “Color Gradient Setup” window and
discard any changes.
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Instrument Parameter Setup
The “Instrument Parameter Setup” window allows the relevant instrument
parameters to be controlled.

Figure 20
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Instrument Parameter Setup dialog for TMDS
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Figure 21

Instrument Parameter Setup dialog for FRL

The selection window comprises several configuration groups (see
Figure 20 and Figure 21):
1

Clock

2

Clock Jitter (available for TMDS mode only)

3

Skew (available for FRL mode only)

4

Additional Jitter (available for FRL mode only)

5

Data Jitter

6

Output

7

Signal Controls

8

Filter

9

Crosstalk (available for FRL mode only)

Following is the description of these configuration groups:
•

36

Clock—The Clock group allows you to modify the HDMI clock setup,
either by means of the Data Rate, the corresponding Pixel Clock, Frame
Rate or Deviation. Changing any of these parameters auto-calculates
the value for others.
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•

Clock Jitter and Data Jitter—The Clock Jitter and Data Jitter setup
groups show the values of the sinusoidal (periodic) jitter Amplitude,
Frequency and Phase parameters, which are generated either by the
clock jitter source or the data jitter source. Select the ‘Enable’ check
box and set the required jitter values to use this specific jitter. Note that
the clock and data jitter parameters can be selected independently (by
default). Alternatively, the clock jitter parameter settings can be
applied to the data jitter (same as Clock). For both clock jitter and data
jitter, an independent ‘2nd Jitter Component’ can be selected and
specified.

•

Skew—The Skew group allows you to set the Intra-Pair and the
Inter-Pair impairment.

•

Additional Jitter—This group enables the possibility to add either
random jitter, ISI or both to the signal.

•

Output—This group provides access to the signal generator output
channels (clock and data) in terms of amplitudes and delay.

•

Signal Controls—The Signal Controls group allows the sequence to be
started and stopped.

•

Filter—The Filter group allows you to set filter parameters, such as
transition times and cable emulators, which are calculated into the
waveform and downloaded to the AWG. The “Auto-configure” button
configures the transition time and ISI model based on the selected
“Video Mode” and “FRL Data Rate”. In TMDS mode, you can manually
configure clock and data transition times. In FRL mode, only transition
time for data can be configured as FRL does not have a clock lane.

•

Crosstalk—The Crosstalk group helps enable crosstalk and select the
victim lane.

After selecting the required instrument parameters:
•

Click “Apply All Settings” to set all parameters simultaneously.

•

Click “Close” to exit the window without saving changes.
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Tools
The options in the Tools menu are:
•

Color Coding

•

SCDC Controller

•

FRL Link Training

Color Coding
This menu provides a tool for converting color code data and is shown in
Figure 22.

Figure 22

Color Coding Conversion tool

This tool enables the RGB Unlimited color mode with different color
depths to be converted to several output color modes, such as RGB
restricted and YCbCr ITU-R 601.
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SCDC Controller

Figure 23

SCDC Controller Software dialog

The SCDC Controller Software allows automatic control of the SCDC
registers. For the SCDC Controller Software to appear (as shown in
Figure 23), click ‘Tools > SCDC Controller’.
This tool is also available as stand-alone software and requires the
following complementary hardware:
•

Adapter cable to connect the controller to a Keysight HDMI fixture

•

Adapter cable to connect the controller to a Wilder HDMI fixture

•

Total Phase™ Aardvark™ I2C/SPI Host Adapter with all included
components

The SCDC Controller Software makes it possible:
•

to supply +5 V at the HDMI connector as required according to the
HDMI specification

•

to read the Character Error Detection from the SCDC register

•

to read the VSDB (Vendor-Specific Data Block) to check the SCDC
availability
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•

to alter the TMDS configuration to set the Scrambled Bit and the Pixel
Clock Ratio

•

to read the TMDS configuration

•

to read the scrambling status

•

to read the EDID (extended display identification data)

•

to read the SCDC

•

to read all the status flags from SCDC

•

to set the FRL rate

•

to read and reset the update flags from SCDC

•

to read the link training pattern requests

FLR Link Training
Clicking this option applies all FRL settings, generates the pattern and
initiates the link training (automatically, if the Auto FLT is selected).
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Troubleshooting and Support

The HDMI Frame Generator software requires that the M8195A Firmware
is running. The firmware must be started once for each M8195A module
used. Also, the M8197A firmware must be started, if a setup configuration
with the M8197A is selected.
Click the “Keysight M8195 Soft Front Panel” icon to launch the Soft Front
Panel provided with the M8195A firmware:

Figure 24

Icon for M8195A SFP

Connect one Soft Front Panel dialog to the desired module. Once the
software is running and connected, a window appears. To get the ‘VISA’
address to connect to this hardware, click Help > About. Right-click the
“About” window and copy the required element, such as, the ‘Hi-Slip’
address and paste it in the required field. An example of the Soft Front
Panel and its About dialog is shown in Figure 25.
When using the HDMI Frame Generator software, use the “Output” tab of
the Soft Front Panel to verify access to the hardware, for instance, by
observing the amplitude levels or the output switches.
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Figure 25
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Keysight M8195A Soft Front Panel window
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